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I. INTRODUCTION 

This study presents structural analysis and design ideas for a planned residential building at. All analyses 

and criteria for structural design input are included in this document. It is the basis for the structural engineer's 

plans to analyse, design, and detail the structure so that it is safe, stable, strong, and cost-effective in accordance 

with Indian Standards and other building standards. Structural analysis and design calculations use this report's 

parameters. This report addresses the minimal design need to develop the unified design base that constitutes the 

structural design philosophy for the proposed construction. 

 

The design will aim to achieve 

 Stability and function. 

 Desirable service design load structural performance. 

 Earthquake resistance. 

 Structural, serviceable, durable, and economical. 

 

II. LITERATURE REVIEW  

 

Varalakshmi V et.al (2014) [1] built the skeleton of a G+5 home from the ground up. IS 875(Part I & II)-1987 

dead and live loads and IS 1986-1985 HYSD bars were employed in this study. They observed that a reinforced 

concrete structure's safety depends on its structural analysis, design, and reinforcing characteristics. 

 

Chandrashekar et.al (2015) [2] ETABS was used for both the assessment and planning of the multi-story 

structure. A G+5 building's response to lateral wind and seismic loads was analysed in ETABS. They considered 

fire spread and the best fireproof material. They offered the innovative and user-friendly ETABS application for 

high-rise structures to save design time. 

 

Balaji.U and Selvarasan M.E (2016) [3] multi-story structures' static and dynamic loads were analysed and 

designed using ETABS. The effects of an earthquake on a G+13 house were analysed using ETABS. For both 

static and dynamic analyses, linear material characteristics were used. Behaviour in areas of high seismicity and 

soil type II was analysed using a non-linear model. Base shear and displacements were charted and analysed. 

 

Geethu et.al (2016) [4] compared STAAD.Pro with ETABS multi-story building analysis and design. They 

designed residential and commercial buildings. The Auto CAD-drafted plan followed the national construction 

code. ETABS software had greater bending moment and axial force readings. 

 Nagaratna et.al Multi-storey structural analysis and design project RCC building analyses multi-storey buildings 

using structural analysis methodologies and software (ETABS). E-TABS software analyses beams and columns, 

while IS: 456-2000's "LIMIT STATE METHOD" designs slabs and footings. Uses M-25 concrete and Fe-415 

steel. 

 

Maruthi T et.al In Civil Engineering, a building is a structure with many parts such a base, ETABS' input, output, 

and Building-type structures' physical and numerical properties are used to solve numerical problems. 

Architectural features include walls, columns, floors, roofs, doors, windows, ventilators, stairlifts, surface 

treatments, etc. Structural studies and design create a structure that can withstand all loads. 

 

B. Anusha et.al. We understand the housing issues in this era of diminishing space, time, and expectation. Any 

institution now offers student hostels. G+4 building with stairs and elevator accommodates 120 students. The 

model is being prepared by ETABS. It is capable of handling complex structures as well as high-rise skyscrapers. 

It performs assessments on beams, columns, slabs, shear walls, and other structural elements. We are able to 
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quickly analyse a wide variety of materials using ETABS, including concrete, steel, reinforced concrete, and 

others. Produce gravitational, lateral, and self-weights on its own automatically. (Varalakshmi V et al-2014). 

 

Chandrakala V B et.al , Civil engineering constructions have foundations, walls, columns, floors, roofs, doors, 

windows, ventilators, stairs lifts, and surface treatments. Design and analysis create load-bearing structures. 

Structural analysis and design need geotechnical study. 

Geotechnical site investigations design and install foundations. Structural engineers must carefully design the 

most cost-effective and functional building for its intended application. 

 

Nilendu Chakrabortty et.al, The successful plan and development of seismic tremor safe structures have a lot 

more significance worldwide, so designs are trying to use various materials to their best advantage, keeping in 

mind the unique properties of each material. Combining the most desirable qualities of a single material with the 

functional and aesthetic requirements of the project results in the construction of the most robust and aesthetically 

pleasing buildings. 

 

Nirmal S. et.al ETABS engineering software analyses and designs multi-storey buildings. Extended Three-

Dimensional Building System Analysis is ETABS. CAD drawings may be used to create ETABS models or as 

templates for ETABS items. Software generates full reinforcement report. Building floor levels are identical, 

reducing modelling and design time. Similar storey model creation for speed. Structural components might be 

steel, RCC, composite, or user-defined. 

 

 Shah H. J. and Jain S. K. et.al, Have examined building earthquake performance utilising various load 

combinations. They also examined high-wind building performance. They also detailed structural components 

utilising Indian Standard Code. Restoring force depends on shear wall location. 

  

 Uma M and Nagarajan (2016) et.al , Changed the shear wall placement to get the best multistorey building 

structural layout. The shear wall at the building corner has minimal displacement and drifts, making it the best 

site. Shear wall material also affects building performance. 

 

2.2 Objectives  

Objectives from the literature review are: 

 This study utilises ETABS to do an analysis as well as the design of a G+3 commercial structure. 

 Using manual methods, design the beam, slab, column, and footing. 

 Manual vs. ETABS outcomes. 

 Auto CAD drawing and reinforcing of structural components. 

 

III. METHODOLOGY 

Stilt, 1st, 2nd, and one more level are planned for the residential construction. RCC beams and slabs support the 

structural framework. Columns are spaced for stability and utility with RCC shear walls. 

Architectural planning and serviceability determine beam planning. Secondary beams are required. 

The system resists the entire design force according to their lateral stiffness considering floor level interaction. 

IS:1893(Part1)-2016 classifies the building as an SMRF. Horizontal diaphragms are floor slabs. 

3-D ETAB Software will be utilised for structural system analysis and design/detail. All designs must adhere to 

Indian requirements. 

 

3.1 SOFTWARS USED: 

3.1.1 AUTOCAD. 

Drafters create drawings and designs using CAD. Autodesk AutoCAD. Drafters create product drawings. 

Engineers, surveyors, architects, and scientists utilise CAD graphics to design buildings, toys, and spaceships. 

CAD drafters know conventional drawing techniques too. 

Drafting includes aeronautical, architectural, electrical, and mechanical specialties. AutoCAD drafters' tasks differ 

by specialty. Drafters utilise CAD software to sketch building proportions, materials, and construction steps. They 

show component-system relationships from numerous viewpoints. Drafters discuss design and layout with 

coworkers. 

Drafters work with builders to define specifications and grasp design ideas. Drafters fix design flaws. Supervisors 

instruct entry-level drafters. 
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3.1.2 ETABS.  

The acronym ETABS stands for "building structure-specific software." Building models may be created, 

modified, analysed, designed, and optimised with its assistance by structural engineers. These technologies have 

been thoroughly incorporated into a graphical user interface that is based on Windows and offers unrivalled levels 

of use, productivity, and power. ETABS is the latest structural analysis and design software. This latest version 

of ETABS incorporates forty years of continuous research and development and provides users with unmatched 

3D object-based modelling and visualisation tools, blazingly fast linear and nonlinear analytical power, 

sophisticated and comprehensive design capabilities for a wide range of materials, and insightful graphic displays, 

reports, and schematic drawings that help users quickly and easily understand a problem's results. ETABS can 

combine engineering design from concept to schematics. Drawing controls speed floor and elevation framing. 

CAD designs may be used to create models and templates for use in ETABS and base plate capacity tests, and 

automated optimization. 

It is possible to create realistic models, and the results may be shown on the structure itself. Structures 

made of concrete and steel could have frame designs, schedules, features, and cross-sections. Personalize each 

and every outcome of the analysis and design. 

The capabilities that ETABS provides to structural engineers are unparalleled, and they may use it to 

design everything from one-story industrial buildings to the largest commercial high-rises. 

Since its introduction many decades ago, ETABS has shown its ability to perform well while being simple to use. 

Its most recent iteration provides engineers with the technically advanced but user-friendly tools they need to be 

productive. 

ETABS performs structural analysis and architectural design for residential buildings.  

 

We choose ETABS for these reasons: 

Easy interface, conforms to Indian Standard Codes, solves any sort of issue, accurate answer. 

 

3.1.3 ADVANTAGES OF ETABS 

 Most constructions use horizontal beams and vertical columns. ETABS may create any building 

structure, However, the geometry of a structure may be generated rapidly using a grid system of horizontal floors 

and vertical column lines. 

 Building floors are similar. Numerically, this commonality reduces computation. 

 Building terminology is used for input and output. Instead of defining models as a series of nodes and 

components as general-purpose programmes do, ETABS does it logically by floor, column, bay, and wall. Clarity 

and utility in structural definition. 

 When comparing bay widths and storey heights, most structures have quite large elements. The rigidity 

of the frame is greatly affected by these measurements. ETABS accounts for this impact in the definition of 

member stiffness, while other general-purpose programmes do not. 

 Program outcomes should be immediately useable by engineers. Generic purpose computer programmes 

generate general outputs that may require further processing for structural design. 

 

3.1.4 APPLICATIONS OF ETABS 

 Commercial high-rises. 

 Staggered trusses. 

 Steel-concrete construction. 

 Multi-grid building. 

 Concrete slab structures. 

 Building exposed to any vertical, lateral, and automated wind and seismic load situations. 

 Floor-to-wall load transmission. 

 

IV. MATERIALS 

4.1 INTODUCTION 

This study resource interacts with students to teach them fundamental structural design principles for Reinforced 

Cement Concrete and Masonry structures. IS 456 general requirements for plain and reinforced concrete 

structural design, IS 1905, IS4326, IS 1893, etc. are covered in the study material. For readers, Indian Standards 

has been simplified and condensed. 

 

4.2 REINFORCED CEMENT CONCRETE DESIGN REQUIREMENTS. 

4.2.1 CEMENT 

Table 4.1:- varieties of cements which are permitted to be used in concrete and mortars such as: 
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Portland Pozzolana Cement (PPC) or 43/53 grade regular Portland cement is recommended for mild to moderate 

environments (OPC). These kinds are mass-produced and typically uniform in quality. Though the performance 

of various cements under varied environmental circumstances is well understood, a particular kind of cement may 

be needed in the following scenarios; 

Concrete needs extremely high early strength. 

a) Concrete must be heat-resistant. 

b) Concrete in sulphate-rich soil/water or other chemically hostile environments. 

c) Cement alkalis may react with aggregate. 

d) The concrete will be employed in a gigantic construction where the temperature increase may produce 

intolerable thermal strains. 

e) Colored concrete is necessary. 

f) The concrete may be exposed to heavy chloride-ion assault in a maritime or industrial environment. 

g) Other unique criteria or combinations of aforementioned requirements. 

 

4.2.2 Portland Pozzolana Cement (PPC) 

Reactive silica may be found in pozzolana. The chemical reaction between calcium hydroxide and siliceous or 

siliceous and aluminous material at room temperature results in cementitious compounds. Cementitious calcium 

silicates (C-S-H) can only be produced by the reaction of finely split pozzolana with calcium hydroxide (liberated 

by hydration Portland Cement) and water. Based on the pozzolanic material used, the Indian requirements for 

Portland Pozzolana Cement are divided into two parts. 

IS 1489, Part 1 and Part 2 specifies Portland Pozzolana Cement are fly ash based and calcined clay based 

respectively. 

  

4.2.3 Sulphate Resisting Portland Cement (SRPC) 

Sulphate Resistant Portland cement is referred to be Portland cement if it contains less than 5 percent tri-calcium 

aluminate (C3A) and 2(C3A +C4AF). SRPC is especially useful in settings where concrete is at danger of 

degradation owing to sulphate assault, such as in contact with soils and ground fluids high in sulphates, in sea 

water, or immediately on the shore. Sulphate-resistant cement causes rebar corrosion in chloride-prone areas. 
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4.2.4  43 grade OPC: 

PPC, PSC, and 43 grade OPC are common general-purpose cements. OPC 43 grade cement usage has fallen as 

PPC has become more prevalent. According to IS regulation, cement's compressive strength at 28 days should be 

43–58 N/mm2. These guidelines' Annexures I and II list this cement physical and chemical characteristics. 43-

grade OPC is often used for: 

a. Common Building Construction Engineering Tasks 

b. RCC works  

c. Concrete roads, bridges and flyovers. 

d. Blocks, tiles, pipelines, and other precast materials. 

e. Non-structural works such as masonry mortars, plastering, flooring etc. 

 

4.2.5  Microfine Ordinary Portland Cement  

Rock grouting, grouting concrete buildings, subterranean construction for leak prevention, soil stabilisation, etc. 

may be done using IS: 16993. 

  

4.3 ADMIXTURES 

To enhance concrete characteristics, additive usage has expanded in recent years. different qualities and functions. 

They're grouped as follows: 

 
 

4.3.1 MINERAL ADMIXTURE 

Mineral admixtures or supplementary cementing materials (SCM) like pozzolanas (including fly-ash, silica fume, 

and metakaoline) and Ground Granulated Blast Furnace Slag may be used to make concrete if they match Indian 

Standards. If suitable and within pozzolana restrictions, such additions may be considered in concrete composition 

for cement content and water-cement ratio. 

 

4.3.2 POZZOLANA or Supplementary Cementing Materials (SCM) 

Pozzolana, a siliceous material without cementitious properties, reacts with calcium hydroxide at room 

temperature to produce cementitious compounds when finely divided and dissolved in water. 

Different building projects employ different pozzolanas. Pozzolanas increase concrete's workability, 

cohesiveness, impermeability, resistance to hostile fluids, heat of hydration, and alkali-aggregate reactivity. 

Construction type will determine the relative relevance of these qualities. Pozzolana is a siliceous material without 

cementitious properties that, when finely split and in water, reacts with calcium hydroxide to form cementitious 

compounds at room temperature. 

Pozzolanas vary every construction project. Pozzolanas improve concrete's workability, cohesiveness, 

impermeability, resistance to hostile fluids, hydration heat, and alkali-aggregate reactivity. These qualities are 

different depending on the kind of construction. At room temperature and in the presence of calcium hydroxide, 
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the inert siliceous material known as pozzolana may create cementitious compounds via a series of chemical 

reactions. 

Pozzolanas vary every construction project. Pozzolanas improve concrete's workability, cohesiveness, 

impermeability, resistance to hostile fluids, hydration heat, and alkali-aggregate reactivity. These attributes 

depend on construction type. 

 

4.3.3 CHEMICAL ADMIXTURE  

Adding a superplasticizer to cement concrete during mixing is necessary to achieve the quality specified in IS 

9103:1999 Specification for admixtures for concrete (first revision). 

 

4.3.4 Accelerating Admixture or Accelerator 

Additives speed up hydraulic cement hydration, set time, hardening, and strength development in concrete, mortar, 

and grout. 

 

4.3.5 Retarding Admixture or Retarder 

An additive that slows cement paste and cement-based compositions like mortar and concrete. 

 

4.3.6 Water Reducing Admixture or Workability Aid 

An aid that allows freshly mixed mortar or concrete to be worked with less water or that makes it workable without 

adding water. 

 

4.3.7 Air-Entraining Admixtures 

A chemical compound that is used to boost the workability, resistance to freezing and thawing, and disruption of 

deicing salt in concrete or mortar by introducing minute air bubbles during the mixing process. This is 

accomplished by the usage of the chemical compound. 

 

4.3.8 Super-plasticizing Admixtures 

A mortar or concrete additive that increases workability or decreases water content. 

 

4.4 AGGREGATES. 

 IS 383 governs aggregates. Prefer natural aggregates whenever feasible. 

 Slag and crushed, overburned brick or tile may be excellent additions to otherwise plain concrete 

components, providing such components with increased strength, durability, and safety. However, the amount of 

sulphates present in the aggregates in the form of SO3 shouldn't be more than 0.5 percent, They shouldn't absorb 

more than 10% of their bulk in water. 

 

4.5  WATER 

 Concrete mixing and curing usually use potable water. Water must be at least 6 Ph. 

 

Table 4.2:-Concrete's Solids-Water Mixing Limit. 
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4.6  REINFORCEMENT 

Steel reinforcement used shall be, 

(a) below Fe415 (conforming to IS:1786) 

(b) Thermomechanically treated high-strength ribbed bars with elongation more than 14.5 percent and adhering 

to IS: 1786 are grade Fe-500 D and Fe-550 D. Tensile test results for steel bars must not exceed their characteristics 

by more than 20%. There has to be between 1.15 and 1.25 times the ultimate strength for every unit of yield tensile 

strength. The elasticity of steel is 2 x 105 MPa. 

 

4.7  CONCRETE 

When fewer than 5% of test results fail, we say that the material is at its usual strength. It's fck. 

 

 
Compressive strength in N/mm2 of a 150 mm cube after 28 days, Concrete Mix M. 

 

 
 

4.7.1 Creep Strain 

a) Creep of concrete: Without changing tension, concrete creeps. Mixture proportioning, ambient 

circumstances, curing conditions, and concrete member geometry affect creep. 

loading and stress. The creep co-efficient μ(t,to) is: 

where 

εcc(t) = creep strain at time t > t0, (This does not include the instantaneous strain in concrete 
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upon loading) 

εci(t0) = initial strain at loading, and 

t0 = age of concrete at the time of loading. 

 

b) Shrinkage Strain 

        The degree to which components, member size, and environmental factors affect concrete shrinkage varies. 

The total quantity of water used in the mixing process has the biggest influence on the shrinkage of concrete at a 

particular humidity and temperature. The cement content has a secondary function in the shrinkage of concrete. 

 

Table 4.3:- Concrete grade, reinforcing steel, and pre-stressing allowed. 

 
 

4.8 WORKABILITY OF CONCRETE 

 

Concrete workability means ease of use. Five workability levels: 

 
 

4.9 DURABILITY OF CONCRETE 

Durability considerations include, 

The result depends on the weather, integrated steel cover, component kind and quality, concrete cement content 

and water/cement ratio, member shape and size, and the quality of the compaction and curing operation. 
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Design and details Maintenance 

4.10 EXPOSURE CONDITIONS: 

Five environmental exposures: 

Some of the potential deterioration mechanisms causing durability problems: 

A. Corrosion of reinforcement due to 

a) Permeation of ambient carbon dioxide in concrete (carbonation-induced corrosion) b) Significant chloride ion 

in concrete (chloride induced corrosion) 

B. Physical deterioration processes; 

Abrasion, freezing and thawing, weathering, shrinkage etc. 

C. Chemical deterioration processes; 

Sulphate attack, alkali aggregate reaction etc. 

 

Table 4.3:-Environmental Exposure Condition 

 
 

4.11 CONCRETE MIX PROPORTIONING 

During concrete mix design, cement, coarse aggregate, fine aggregate, water, and sometimes additives are 

calculated to achieve the required workability of fresh concrete and strength, durability, and surface quality of 

hardened concrete. 

Concrete may be mixed in one of two ways: 

i. Design mix concrete 

ii. Normal mix concrete 

M20 and higher should use design mix. Only M20 and weaker concrete may utilise nominal mix. 

 

Table 4.4:- Grades of concret 

 
 

4.12 CURING 

Curing keeps concrete wet. 

Low water cement ratios need concrete moisture retention. Curing has two main types: 
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i. Moist curing 

ii. Membrane curing 

 

V. STRUCTURAL DESIGN CONSIDERATION 

4.1 The purpose of design is to accommodate the following conditions: 

(1) Safety 

(2) Economy 

(3) Durability 

(4) Robustness 

(5) Integrity 

(6) Serviceability  

(7) Aesthetic 

(8) Sustainability 

 

5.2 LOADS 

There are 2 sets of loads 

▪ Force Loads 

▪ Displacement Loads 

Force Loads 

✓ Dead Load 

✓ Wind Load 

✓ Snow Load 

✓ Earth Pressure 

✓ Water Pressure 

✓ Blast Load 

✓ Imposed Load 

✓ Impact Load 

✓ Prestressing Force 

✓ Construction/ Erection Load 

Displacement Loads 

✓ Temperature Load 

✓ Shrinkage Load 

✓ Creep Load 

✓ Elastic Shortening Load 

✓ Foundation Settlement/ Movement/ Rotation 

✓ Earthquake Ground Shaking 

 

5.3 FIRE RESISTANCE 

 Using fire-resistant materials and covering steel makes a structure fireproof. Fire resistance is measured 

in hours. 
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Table 5.1:- fire resisting ratings 
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5.4  Types of Analysis 

 
 

5.4.1 Static Lateral Force Method 

The similar static lateral force approach gives an easy alternative for constructing against the dynamic loads of an 

expected earthquake. The whole seismic force, denoted by the symbol V, has been assessed along two horizontal 

axes that are perpendicular to the primary axis of the structure. 
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It presupposes lateral response. To eliminate subsurface torsional movement, the structure must be low-rise and 

symmetrical. Seismic forces must not affect the building in both directions. 

 

5.4.2 Linear Dynamic (Response spectrum) analysis 

Construction uses reaction spectrum analysis (RSA). Modal decomposition and the response spectrum 

simplify response history analysis (RHA). Peak response is quickly determined without response history analysis. 

This is crucial because response spectrum analysis (RSA) uses fast and simple calculations, unlike time history 

analysis, which solves the differential equation of motion over time. The response spectrum represents earthquake 

risk. 

The greatest reaction of an SDOF system versus time during an earthquake creates a response spectrum 

(or frequency). The damping ratio's maximum response locus determines the SDOF system's response spectrum. 

Response spectra allow peak structural responses in the linear response range to determine earthquake-induced 

lateral forces. Peak structural responses in linear response range enable this. 

SDOF system response is determined by time- or frequency-domain analysis. The study determines the 

largest reaction over a certain time period. This applies to all SDOF ages. The last figure shows the damping ratio 

and input ground motion response spectrum 103. Damping ratios determine response spectra. 

 

5.4.3 Non-linear Static (Push-over) Analysis 

Pushover analysis—a nonlinear static analysis—loads a structure arbitrarily. Loading exacerbates structural 

weaknesses and failure mechanisms. A modified monotonic force-deformation criteria and damping 

approximations characterise cyclic behaviour and load reversals. Structural engineers assess structure strength 

using static pushover analysis. Performance-based design may use this research. 

An evaluation of a pushover based on performance. The ATC-40 states that in order for performance-based design 

to be possible, demand and capacity must first exist (Applied Technology Council, Seismic Evaluation and 

Retrofit of Concrete Buildings). The shaking of the ground and buildings that occurs as a result of an earthquake 

is an analogy for demand. Nonlinear static analysis gives preliminary approximations of structural displacements 

or deformations in order to take into account demand. Evaluation of earthquake resistance is often done using 

capacity as the criterion. Key aspects of performance include capacity as well as the ability to satisfy requirements. 

As a consequence of this, earthquake resilience is an essential component of the building's overall design. 

Pushover analysis using the displacement coefficient and capacity spectrum technique. 

Pushover analysis—a nonlinear static analysis—loads a structure arbitrarily. Loading exacerbates structural 

weaknesses and failure mechanisms. A modified monotonic force-deformation criteria and damping 

approximations characterise cyclic behaviour and load reversals. Static pushover analysis is a method that 

structural engineers use to evaluate the true strength of a structure. This study may be seen of as a possible strategy 

for performance-based design. 

An evaluation of a pushover based on performance. The ATC-40 states that in order for performance-based design 

to be possible, demand and capacity must first exist. The shaking of the ground and buildings that occurs as a 

result of an earthquake is an analogy for demand. Nonlinear static analysis gives preliminary approximations of 

structural displacements or deformations in order to take into account demand. Evaluation of earthquake resistance 

is often done using capacity as the criterion. Key aspects of performance include capacity as well as the ability to 

satisfy requirements. As a consequence of this, earthquake resilience is an essential component of the building's 

overall design. 
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5.4.4 Nonlinear Dynamic (Time History) Analysis 

Time-history analysis. Nonlinear structural seismic analysis needs it. This investigation needs a structure's 

representative seismic time history. Time history analysis steps through a structure's dynamic reaction to a variable 

loading. Time history analysis determines a structure's seismic response under representative earthquake dynamic 

loads. 

 

VI. ANALYSIS AND DESIGN OF PROPOSED G+3 RESIDENTIAL BUILDING 

6.1 Salient Features of Project: 

G+3 residential building. It has two tales and a feature piece. Drawings show the site's normal floor arrangement 

and functioning. The building has a stairwell. 

Each level will cover: 

6.2 PROPOSED PROJECT  

Ground-floor, two-story residential building is proposed. Bangalore's executing. 

 

Table 6.1:- Project details 

 

 

 

 

 

 

 

 

 

 

 

 

 

6.3 Structural Plan: 

Floor-to-floor structural plans vary according to customer needs. Sometimes the architect may propose 

alternative plans for different levels, considering the aesthetics and space requirements of a structure. The 

structural plan mostly deals with the column-beam arrangement. Floor plans will vary in this project. The floor 

plans of the building are shown below. 

1.Type of structure Residential building 

2.Layout As shown in the plan 

3.Number of storey G+3 

4.Storey height 3.0m 

5.Depth of foundation 2.1 

6.Wall 230mm thick 

7.Live Load IS 875(Part-2)1987 

8.Material M20 grade concrete&Fe500 steel 

9.Design Philosophy Limit state method conforming to IS456-2000 
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Fig 6.1:- Ground floor 
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Fig 6.2 :- first floor 
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Fig 6.3:- Second floor 
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 Fig 6.4:- Terrace floor 
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Fig 6.5:- Column layout plan 
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Fig 6.6:- Plinth Beam layout plan 
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Fig 6.7:- Stil floor Beam layout. 
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Fig 6.8:- 1st Floor roof lvl. beam framing plan 
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Fig 6.9:- Terrace Floor lvl. beam framing plan 
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Fig 6.10:- Terrace Floor lvl. Beam framing plan 
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Fig 6.11:- Foundation layout plan 
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Fig 6.12:- Section elevation  

 

VII. LOADING PARAMETERS 

7.1  Design Data: 

ETABS software analysed and designed a three-story reinforced concrete asymmetrical frame structure. 

Residential building. Assuming infinite rigidity in its plane, the building floor moves like a rigid body. Linear 

static analysis was done. Seismic zone II and medium soil host the building. 

7.2 Building details: 
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Table 7.1:- load calculation 
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7.3 Staircase Loading. 

Loading Per Meter Width of Flight 

 

R=150, T=250,  Hence Sqrt ((150)^2+(250)^2)) = 291.5 ≅ 292mm 

Waist Slab      = [0.150 x 292 x 25]/250 

                        = 4.38 KN/Sqm 

Steps               = (0.150 x 25)/2 

                        = 1.875 KN/Sqm 

Finishing         = 1 KN/Sqm 

Total                = 7.3 KN/Sqm ≅ 7.5 KN/Sqm 

 

7.4 Earthquake/Seismic Loads 

Assessment of earthquake loading is performed in accordance with the requirements of IS: 1893-2016. You'll 

find Bangalore in Zone-III. The following considerations are made: 

Seismic loads and how they are distributed across the building's height and throughout its numerous lateral load 

resisting parts as per the design. 

 

 

 

 

 

 



“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            254 | Page  

Table 7.2 Seismic Load Calculations 

 
 

Table: 7.2 Covers For Structural Elements 

 
Clause 21 of IS 456-2000 specifies minimum sizes for fire-resistant reinforced concrete members. 

Table: 7.3 MINIMUM DIMENSIONS OF REINFORCED CONCRETE 

 
 

According to clause 21 of IS 456 -2000 (table above), minimum beam width for 30 minutes fire resistance is 

200 mm and minimum column cover to reinforcement is 40mm. IS 13920-1993 requires 200mm beam width. 

Clause 7.1.2 requires 200mm columns. 

 

7.5  FOUNDATION SYSTEM 

Building footings will be segregated. The foundation will be constructed for 180 KN/m2 Net Safe Bearing 

Capacity using ETAB Model reaction. 

 



“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            255 | Page  

7.6  DETAILING OF STRUCTURES 

IS: 456 and SP: 34 detail all structural elements. Detailing should fulfil minimum and maximum R/F and bar 

spacing criteria. 

 

VIII. MODELING USING ETABS 

 

Step 1: Modeling using ETABS 

1) Start ETABS 

2) In the drop-down box at the very right of ETABS, choose kN-m as the model units. 

3) Select File>New model. 

Change units, steel, and concrete codes and click OK. 

 

 
 

4) The next step is to define the building's data and the building's grid system. Alter the distance between each 

grid square. Grid spacing and custom storey data are used to determine building height. As seen in drawings. 
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“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            257 | Page  

5) Choose Concrete Frame Design from the "Options" menu's "Preferences" to set the design code. 

Command 

 

 
 

This will Display the Concrete Frame Design Preference form as shown in the figure. 

 
 

6) Click Define > Material Properties, then click Modify/Show Materials, and then click OK to add materials 

like concrete grade and steel grade by area. The numbers are below. 
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7) Columns and beams may be defined by selecting Define > Frame section. 

Click add new property > click rectangle > ok 
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Define beam sizes, click Reinforcement, and cover columns with concrete. Checked or planned reinforcement. 

Prefer checking reinforcement. 
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8) Define wall/slab/deck. 

Special one-way load distribution is used to describe a slab as a membrane or shell thin element and a one-way 

slab. 

Slab-based features may be added or altered. 

 

 
 

 

9) Generate the model 

Make instructions for a line and a column to sketch a beam and a column. 
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There are three ways to make a slab: (1) draw an area of any form; (2) draw a rectangular area; or (3) make an 

area in between grid lines. 

  

 

 

 
 

 

The above choice created the model shown below. 

 
Go to define > load pattern > click 

11) Seismic force calculation as per IS: 1893(Part 1) - 2002. 

(a) Static Method 

Create the model, analyse and design it (RCC design), and then verify it. 

 

Break the model and define seismic load patterns as indicated below. 
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Dead Load: default self weight multiplier is 1. 

Live or other defined load 

 

Access the definition of static load by selecting Define > Static load. 

Please adjust the lateral load to the amount provided below, and assign a different value in accordance with IS 

1893-2005. 

 
 

load combination, envelope, and model. Show tables and record these values after analysing the structure: 

1. The Story Drift must not be more than 0.004 times the height of the storey. 
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The most extreme base reaction, FZ (When you're through, compare this number to the results of a 

straightforward analysis.) 

 

12) Assigning the live , dead, ffl, and wall load  

Click the assign button once you have chosen the person to whom this load will be assigned. 

 Assign > shell area loads > uniform > click ok 

 

 
Frame load Assignment> uniformly spread Add the load pattern to existing loads > uniform load > ok > 

member element > ok. 

 
 

13) Assign support condition 

In the ETABS window's lower-right drop-down menu, choose the level you want to give the fixed support for 

using the "Create One Storey" button. 

assign > Joint/Point>Restrain (Support) command> fixed 

one storey bottom left corner and assign 

 
 

14) Assigning the diaphgram 

 Earthquake analysis treats slabs as rigid members. First, diaphragm action is applied to all slabs for stiff or 

semi-rigidity. 
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13) Meshing of Slabs  
Select all of the slabs that will be used in the analysis (F5), then go to the Analyze menu, select Automatic 

rectangular mesh settings for floor, and then click on the Mesh customisation panel. 

For best results, set the meshing size to 0.6 from the usual 1.25. 
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14) Assigning end release 

Assign>frame>partial fixity> then as indicated in figure. 

 

 

 

 

 

15) Load Combinations 

If you want full creative control over your ideas, it's advisable to create your own load combination rather 

than rely on ETABS's proposed "UDCON2" load combination for dealing with the partial safety problem. 

Load combinations are created as follows. 

Define——>Load Combinations——> Click add new combination in that window. 
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After clicking Add new combination, the safety factor window displays as shown below/next page (1 for DL 

and 1.5 for LL). The model may be analysed for post-processing outcomes when all load allocations and 

combinations are defined. 

 
16) Define>mass source defines mass source. IS: 1893-2002 requires 25% live load (of 3 kN/m2) on all floors 

excluding roof. 
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17) Run analysis from Analysis > Run Analysis command 

 
 

 

18) Concrete Design  
Click Design -> Concrete Frame Design -> Start Design / Check (Shortcut sft + F6) to begin concrete designing 

once you have finished modelling, allocating loads, and analysing load combinations. This will confirm your post-

processing results (SFD & BMD). 
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The structural evaluation and design process results in a design model that looks like the one shown below. 

 
Design > Concrete Frame Design > Display Design Information shows steel percentages and column beam steel 

areas. 
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The above figure shows total load acting on buling . 

 

 

19) Dimensions of time and the mode of occupancy in the X and Y axes of the structure. 

• According to the IS 1893, the time period is 0.075H0.75, which is equal to 0.34 seconds in the X-direction and 

0.46 seconds in the Y-direction. 

Select Display > Show Mode Shape to see the time period in ETABS. 
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Your are able to see the proportion of the total population that is actively participating in the model by choosing 

Display > Show Table > Model Information > Building Model Information > Model Participating Ratio from 

the drop-down menu. 

 

 
 

20) Design check  

The sixth step is to build a model and load combinations and envelope. Analyze results 

Seventh, verify the aforementioned outcomes 

The greatest possible drift between floors is 0.004, or 0.004 times the floor height. 

You should use the Equivalent Static/Linear Static Method if your Base Reaction FZ is more than the Maximum. 

Third, the total mass participation in the x and y modalities must equal at least 90 percent of the lateral loads in 

order for this condition to be met. 

Fourth, verify the mode shapes or distorted forms; the first three should represent x or y changes. 

If the following requirements hold true in the response spectrum analysis, the model may be considered stable and 

unaltered. 

 

Additional Points and Notes :-  
1. The limitations of storey drift are specified in IS 1893-2002. (Part-1) Clause 7.11.1 

Time periods must be manually determined for determining the load pattern in comparable static analysis; the 

method for doing so varies depending on the kind of building being analysed. 

Page 24 of IS 1893-2002, Part-1, Clauses 7.6.1 and 7.6.2. 

Page 25 of IS 1893-2002, Part-1, contains the comparative information of the base reactions. 4. For information 

on accommodating soft storeys, please see Clause 7.10.1 on Page 27 of IS 1893-2002. 

21)Left-click any beam member to see below figure. 

The figure illustrates the Pu-Mu interaction curve as well as shear, flexural, and beam/column features. 
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ETABS 2013 Concrete Frame Design 
IS 456:2000 Column Section Design 

 
Column Element Details  Type: Ductile Frame  (Flexural Details) 
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“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            276 | Page  

 
 

ETABS 2013 Concrete Frame Design 
IS 456:2000 Beam Section Design 
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  221.69 0.4427 43.0429 190 410 
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VIII. STRUCTURAL ANALYSIS AND DESIGN 

8.1 General 

Structural engineering researches, plans, designs, builds, inspects, monitors, maintains, rehabs, and demolishes 

permanent and temporary structures, structural systems, and their components. Structural design evaluates 

stability, strength, and stiffness. Structural analysis and design create structures that can sustain all loads over their 

lifetime. Structures bear loads. If the structure is poorly designed or built, or if the applied loads exceed the design 

constraints, the device may fail to fulfil its intended purpose, which might be devastating. 

 

8.2 IMPORTANT POINTS FOR BEAMS 

 For grades Fe 415 and Fe 500, maximum tension bar spacing is 180 mm and 150 mm, respectively. 

 Ast = 0.85bd/fy for beam tension reinforcement. Maximum tension and compression reinforcement in 

beams is Ast < 0.04bd. 

 The clear span between lateral supports of a simply supported or continuous beam should be no more 

than 60 b or 250 b2/d. 

 Cantilevers must have a clear space of 25 b or 100 b2/d from the free end to the lateral constraint. 

 For vertical stirrups, shear reinforcement must not exceed 0.75d along the member's axis, where d is the 

section's effective depth. Never surpass 300mm. 

 Asv/b.Sv < 0.4/fy must be given by stirrups. 

Where, 

Asv  = total cross sectional area of stirrup legs effective in shear 

Sv    = stirrup spacing along the length of the member 

b     = width of the beam 

fy   = should not be more than 415 N/mm² 

• Positive moment reinforcement 

i.  Simple members require Ld/3 of the positive moment reinforcement along the same face into the support, 

whereas continuous members need Ld/4. 

ii. The positive reinforcement that must be extended into the support in accordance with (a) must be anchored 

such that it produces its design stress in tension at the support face when the flexural member is part of the 

principal system for withstanding lateral loads. 

iii. At inflection points and simple supports, reinforcing positive moment tension must be less than M1/V + Lo. 

Where, M1 = moment of resistance if all reinforcement is strained to fd 

             fd = 0.87 fy in the case of limit state design and the permissible stress 

                     in the case of working stress design σst 

             V = shear force at the section due to design loads 

            Lo = sum of the anchoring beyond the centre of the support and the support provided by any hook or 

mechanical attachment. At inflection, Lo cannot exceed 12 or the effective depth of the members, whichever is 

larger. Crushing the reinforcing ends increases the bar's diameter by 30% to the M1/V ratio. 

 

• Negative moment reinforcement 

i.  At the point of inflection, one-third of the negative moment reinforcement at the support must extend outward 

for a distance equal to or more than the effective depth of the member by 12, which is one sixteenth of the clear 

span. 

• Curtailment of tension reinforcement in flexural members 

i. Except for the simple support or cantilever end, reinforcement must continue beyond the point at which it no 

longer resists flexure for the effective depth of the member or 12 times the bar diameter, whichever is larger. This 

criteria does not applicable when the reinforcement cannot withstand flexure. 

ii. Any of the following in a stress zone requires flexural reinforcement removal. 

a. At the cutoff point, shear strength is two-thirds of the maximum allowed (this includes the web 

reinforcement). Web reinforcement limits shear at the cutoff point. 

b. Each terminated bar has stirrup area greater than shear and torsion for three fourths the member's effective 

depth from the cutoff point. The extra stirrup area must be at least 0.4bs/fy, where b is beam width, s is spacing, 

and fy is reinforcing strength in N/mm2. The spacing must not exceed d/8βb, where βb is the ratio of bars chopped 

off to total bars at the section and d is the effective depth. 

c. For bars with a diameter of 36 millimetres or less, continuing bars offer twice as much room as needed for 

flexure at the point where they are cut off, and the shear does not exceed three quarters of what is allowed. 

• Lap splices 

i. In order to join bars larger than 32mm, welding or mechanical splicing is required. 
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ii. For bars in flexure tension, the lap length is Ld or 30, whichever is bigger; for bars in direct tension, the lap 

length is 2Ld or 30, whichever is greater. The minimum length of the lap is 15 inches (or 200mm). 

iii. Compression lap length should equal development lap length (as calculated in 26.2.1), but not be less than 24. 

iv. Joining 2-inch-gap bars. The shorter bar's diameter determines lap length. 

 

• Temperature, creep, and shrinkage after drywall and finishes are completed shouldn't be more than span/350, or 

20 mm. 

• Most of the time, the ultimate deflection owing to all loads (temperature, creep, and shrinkage) should not exceed 

effective span/250, measured from the floor supports' as cast level. 

 

 

 
CONTINOUS BEAM 

 
CANTILEVER BEAM PROJECTION FROM A COLUMN 
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CANTILEVER BEAM PROJECTION FROM A BEAM OVER COLUMN 

 

 8.2  IMPORTANT POINTS FOR SLABS 

• If a slab extends in many directions, choose the shortest route to calculate its span-to-effective depth ratio. 

• The span-to-depth ratio below should meet vertical deflection requirements for loads up to 3 kN/m2 in two-way 

slabs reinforced with mild steel and shorter spans (up to 3.5 m).Continuity 35, Structures That Are Supported By 

Slabs Simply multiplying by 0.8 will provide you the high strength Fe 415 warped bars you need. 

The figure takes into account loads that are equally distributed when depicting beams that support solid slabs 

that span in two different directions at right angles. below. 

 

 
 

•   Major reinforcing bar spacing on the horizontal plane must not exceed 300 mm or three times the effective 

depth of the solid slab. 

• Shrinkage and temperature impacts need minimum strengthening of slabs. Mild steel reinforcement at the rate 

of 0.15 percent in both directions is required for slabs. When using high-strength bent bars, that percentage drops 

to 0.12%. 

• Reinforcing bars cannot exceed 1/8 of the slab's thickness. 

• Slabs have maximum bending moments per unit width. 

equations: 

Mx = αx. w. lx² 

My = αy. w. lx² 

Where, αx and αy are coefficient given in table 26. 

w = total design load per unit area 

Mx and My = moments on strips of unit width spanning lx and ly respectively. 

lx and ly = • In accordance with figure 25 of IS code 456, slabs are divided into central strips and edge strips in 

both directions. The central strip is three quarters the slab's width, while the outer strip is one eighth. 
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D-1.1 does not disperse centre strip maximum moments (IS 456). 

• At least half of the tension reinforcement must reach 0.3l from the support in the top section of the slab over the 

continuous borders of a middle strip. 

Edges that don't quite connect might have negative moments. Tension reinforcement equal to 50% of the mid span 

and 0.1 times l into the span is usually adequate. 

The minimum requirements of Section 3 and the torsion criteria of D-1.8 through D-1.10 must be met by the 

reinforcing strips installed parallel to the edge. 

When a slab is supported on two sides, it is essential that torsional reinforcement be provided to each corner. Bars 

running parallel to the slab's edges and outward for at least a quarter of the shorter span will be used for top and 

bottom reinforcement. Three-quarters of the slab's mid-span moment reinforcement will be distributed between 

these four layers. 

• In a corner with a single continuous slab edge, half the D-1.8 torque reinforcement is required. 

Torsion reinforcements are unnecessary in the corners of a slab with a continuous edge at the corner. 

If torsion ly/lx is more than 2, slabs should span only in one direction. 

• For slabs that are simply supported, the maximum moment per unit width is given by the following equation, 

assuming no special measures are taken to prevent twisting at corners or lifting. 
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TYPICAL DETAILS OF TWO WAY SLAB (RESTRAINED SLAB) 

 
DETAILING OF ONEWAY CONTINUOUS SLAB AS PER SP 34 (PG:127)

 

 
 

 

 TYPICAL DEAILS OF ONE WAY SLAB AS PER SP34:1987 (#CL.9.3.1) 
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8.3 IMPORTANT POINTS FOR COLUMNS 

• Columns and struts have effective lengths over three times the least lateral dimension. Pedestal if less than three. 

• The lex/D and lex/b ratios of a compression member must be less than 12 for it to be considered short. 

• The apparent gap between the compression members and the restraints is referred to as the unsupported length, 

which is denoted by the letter l. 

The distance between end restraints must be no more than 60 times the smallest lateral dimension of the column. 

• The unsupported length, l, of a column must be less than or equal to 100b2/D. 

There can be no quirkiness in the columns. 

Minimum allowed dimension (emin) = unsupported length (lun) 500 + side length (dx) 30 or 20 mm. 

The gross column cross section must be between 0.8 and 6% of the longitudinal reinforcement cross section. Use 

less reinforcing as 6 percent may hinder concrete laying and compacting. Lapping bars from lower columns with 

those in the column under consideration should employ no more than 4% steel. The minimal steel percentage 

should be computed on the concrete area that must sustain direct stress in columns with a larger cross sectional 

area than needed. Instead of basing the proportion on area, do this. The minimum diameter for a bar is 12mm; 

four longitudinal bars are needed for rectangular columns and six for circular ones. 

 

8.4 IMPORTANT POINTS FOR FOOTINGS 

• Reinforced and plain concrete footings on soils need 150mm edge thickness. 

• The greatest bending moment at a section must be determined for a freestanding concrete base supporting a 

column, pedestal, or wall. 

i.e., foundations for a single column or wall. 

Footings for masonry walls should be placed midway between the centre line and the wall's edge. 

iii) For footings beneath gusseted bases, midway between the column or pedestal and the base. 

• Footings are vulnerable to shear failures in both directions (punching shear) 

The effective depth of a footing, denoted by the symbol d, is what establishes the minimum distance that a critical 

section must be from the face of a column or wall in the case of one-way shear. 

There is a critical region that is d/2 distant from the face of the column in two-way shear. where d refers to the 

depth of the foundation that may be used. 

A bearing transfers concrete compressive stress from the base of a column or pedestal to the top of the footing or 

pedestal. The loaded zone bearing pressure must not exceed the bearing stress limit in direct compression times 

(A1/A2) up to 2. 
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Where A1 is the supporting area for footing bearing, which in sloped or stepped footing may be taken as the area 

of the lower base of the largest frustum of a pyramid or cone contained entirely within the footing, and having for 

its upper base, the area actually loaded, and side slopes of one vertical to two horizontal; and where A2 is the area 

of the upper base. 

A2 = Loaded area at the column base 

 

8.5 WORKING STRESS METHOD (WSM) 

The lower base of the biggest frustum of a pyramid or cone wholly enclosed within a sloping or stepped footing 

determines its bearing area. This base should have a heavy top base and side slopes from one vertical to two 

horizontal. 

 

8.6 LIMIT STATES METHOD (LSM) 

The LSM, or limit states approach, enhances conventional design practises. In contrast to WLM and ULM, LSM 

takes into account both safety at ultimate loads and serviceability at working loads. LSM uses a multiple safety 

factor framework to provide safety at ultimate loads and serviceability at all service loads by considering all "Limit 

states" (limit state of collapse, limit state of serviceability). Probabilistic safety factor selection should include 

failure mechanisms, material attributes, and loads. 

 

8.7 LIMIT STATE METHOD Vs WORKING STRESS METHOD 

 
  

. 
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IX. Design of Two-way slab for Residential building 

Design steps: - 
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e) Moment and shear forces 

Referring to IS 456-2000 code B.M co-efficient are as follows,  

From table 26, page no.91  

                                                    Shorter span, αx           longer span, αy  

-ve moment at continuous edge              0.063                  0.037  

           +ve moment at mid span                         0.047                 0.028 

Calculation of maximum bending moment:  

-ve moment at continuous edge:  

 

For shorter span =αxwulx2  

                           = 0.063x12.49x(4.011)2  

                           = 12.65 kN-m  

For longer span   = αywulx2  

                             = 0.037x12.49x(4.011)2  

                             = 7.4 kN-m  

+ve moment at mid span:  

 

For shorter span = αxwulx2  

                            =0.047x12.49x(4.011)2  

                            = 9.44 kN-m  

For longer span = αywulx2  

                            = 0.028x12.49x(4.011)2  

                            = 5.62kN-m  
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        SPAN DIRECTION MOMENTS 

Area 

(mm2) 

Short span 

+ve moment(kNm) 
9.44 kN-m 201 

-ve moment(kNm) 
12.65 kN-m 270 

Long span 

+ve moment(kNm) 5.62kN-m  180 

-ve moment(kNm) 7.4 kN-m  180 

f) Check for area of steel 

As per IS 456 clause 26.5.2.1 

Min.Ast = 
0.12

100
𝑏𝐷 

 =0.012X1000X125=150mm2   

g) Check for spacing 

As per IS 456:2000 Clause. 26.3.3(b) 

Short span: Assuming 8mm ϕ bar,  

  Spacing =   
𝜋

4
(8)2

201
∗ 1000  =250mm  

 Spacing =   
𝜋

4
(8)2

270
∗ 1000  =186mm  

long span: Assuming 8mm ϕ bar,  

  Spacing =   
𝜋

4
(8)2

180
∗ 1000  =280mm  

 Spacing =   
𝜋

4
(8)2

150
∗ 1000  =335mm  
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Hence Provide 8mm ϕ bar at 125mm c/c. At  (Along X-direction). 

          Provide 8mm ϕ bar at 150mm c/c. At  (Along Y-direction 

h) Check for shear stress 

Vu = 0.5*Wu*Lx 

     = 0.5*(12.49)*(4.011) 

Vu = 25KN 

Considering slab width and shorter span. 

 τv=(
𝑉𝑢

𝑏𝑑
) = 

(25∗1000)

1000∗101
    =0.24N/mm2 

 τv =0.24N/mm2 

 pt=
100𝑎𝑠𝑡

𝑏𝑑
 =

100∗270

1000∗101
  =0.25 

  

 

 
i) Check for deflection control 
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ii) Reinforcement details 

 
 

 

 
 Fig. 9.1 Reinforcement details in Two way slab 

 

 

 

 

 

 

 



“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            290 | Page  

9.2  Design of  Singly reinforced Beam,  

 

Design: 

Data: 
Fck=25N/mm2 

Fy=500N/mm2 

Length =4.822m, b=300mm, D=450mm 

Max moment (Mu) = 34.665KN-m (from Etabs software) 

Shear force (Vu) =43.043KN 

Assuming 12mm dia bars with 30mm clear cover 

d=450-30-12/2 = 414mm 

Compare Mu and Mu,lim 

Mu,lim = 0.133Fckbd2    For Fe=500Mpa 

= 0.133*25*300*4142 

=  170kN-m >Mu 

 The section is under reinforced hence it is singly reinforced beam is design,. 

Determine the value of Xu,max for given type of steel(#cl.38.1) and calculate Mulim of the section (Annex – 

G,#G1.1©) 

Area of steel  required( Annex - #G1.1(b) 

Mu =0.87*Ast*d*Fy*[1 −
Ast∗Fy

B∗d∗Fck
] 

Ast,req=263mm2 

Xu, max/d=0.46 for fe 500MPa (cl 38.1 IS-456, Pg: 70) 

  
Xu/d < Xu,max/d hence the section is under reinforced 

Ast,min =( 0.85 b d/ fy)                  ( IS 456-200 Pg:47) 

Ast,min = 161.874 mm2 

Ast,max= 0.04bd = 0.04 x 300 x 450 = 5400 mm2 

No of bars =Asc/area of single bar =
263

𝜋(12)2/4
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                                                        =2.32=3 

Provide 3 bars of 12mm diameter(Asc(provided)=339mm2) 

Check for shear: 

Vu=43.0430KN 

τv= Vu/bd 

=(43.0430*103)/(300*414) 

=0.35N/mm2 

τc=100*Ast/bd 

=(100*339)/(300*414) 

=0.27 

from table-19 IS-456-2000 

 

=[43.043*1000-(0.38*300*414) 

Vus=140.62KN 

Using 8mm diameter bar 2LVS 

Sv=
0.87∗𝑓𝑦𝐴𝑠𝑣𝑑

𝑉𝑢𝑠
 

Sv=173.23=180mm 

Sv>0.75d=(0.75*414)=310mm 

Sv=200mm 

Provide 8mm diameter 2LVS @ 200mm c/c. 

Check for deflection: 
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Reinforcement Details 

 

 
Fig. 9.2 Reinforcement details in Plinth beam 
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9.3 Design of short columns under compression and biaxial bending (C6).  
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Fig 9.3.1:- Bending moment, shear force and axial force. 
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“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            296 | Page  



“Analysis and Design of G+3 Building Using ETABS” 

www.ijres.org                                                                                                                                            297 | Page  

 
Fig 9.3.1:- Reinforcement Details Of Column 
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9.4 Design of RCC Isolated Footing: (F7) 
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 Fig. 9.4.1 Reinforcement details of Footing 

 

X. RESULT AND CONCLUSION: 

G+3-storey apartment building analysis and design. ETABS V13.2, a premium section analysis and design 

programme, is used. RCC frame, shear wall, and retaining walls. The soil investigation report gives an isolated 

footing. ETABS developed RCC beams and columns. Analysis and design were as conventional as possible. 

Recognized were the structural engineer's design problems. 

Manual design and software analysis data for structures 

 

Following conclusions are drawn:  

ETABS was used to analyse and manually verify IS456. 

2. Manual and computerised calculations provide similar results. 

3. Results match when expanded to a 4-story structure. 

4. ETABS is ideal for study and design of a four-story structure with identical levels. 

5. ETABS reduces analysis and design time. 
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IS-CODE STANDARDS 
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